Geneseo Central School
Middle/High School 6-12
Student Research Guide
Table of Contents

2 … Documentation and Plagiarism
3 … Choosing Valid Sources
4 … Notecards and Note Taking
5 … Creating an Outline
6 … Standard ELA Outline Model
7 … The Thesis Statement
8 … Tips for Writing Your Thesis Statement
9 … Thesis Statement Examples
10 … Modern Language Association (MLA) Manuscript Form
11 … Sample MLA Paper Format
12 … MLA In-Text Citations
13 … Sample of Common Works Cited
14 … MLA Standard Format
15 … Online Resources
16 … Glossary
Documentation and Plagiarism

Plagiarism is the representation of another’s ideas or writing as one’s own.

All research projects and papers submitted by Geneseo Central students must be their own work!

Plagiarism is considered any of the following:
- The use of another person’s words, image, or brand and passing it off as your own original thought
- Copy and pasting web site content without giving credit to the author
- Omitting quotation marks on content found in another source
- Using words from another source with the incorrect information or citation
- Using words and the same sentence structure of a source without citations

While plagiarism can occur in several ways, the most common acts of plagiarism are as follows:
- A deliberate attempt on the part of the student to claim another’s work as his/her own writing or ideas (student, parent, published or unpublished author, et al.)
- A failure to acknowledge (cite) outside material that results from the student’s lack of attention to proper procedures for documentation

To avoid plagiarism, you can follow a few easy steps:
- Always write down the sources that you use in your research.
- If you have used an idea from another author, cite it with parenthetical documentation and on the Works Cited page.
- If you are in doubt about whether to cite a source or not, cite it.
- When taking notes restate your information in your own voice.
- If you have any uncertainties, ASK A TEACHER! Teachers are willing to help in any way they can.

Any type of plagiarism will result in a disciplinary consequence.
Choosing Valid Sources: Reliable or Unreliable?

Consider these guidelines when deciding whether or not a resource will give you accurate information:

**First Glance**

1. Is the author (or the person delivering the information)…
   - An expert in the field, well-known, a researcher, connected to a reputable organization
   - Able to be contacted (e-mail, social network, postal mail,)
   - An author of other articles listed in bibliography
2. Is the publisher…
   - Well known or has a reputation for quality materials
   - A website
     - Who is the sponsor or page domain
     - Is it a .com (commercial- anyone could have one), .org (non-profit), .edu (education), .gov (government), .net (network)
   - Is there a bias
3. Is the date appropriately current?
4. Are their reviews created by an editor and/or a peer review group?
5. Is the information from…
   - A reliable source
   - An authority on the topic (teacher, researcher, scientist, professional in the field)

**Second Glance**

1. Who is your intended audience?
2. Does it include a bibliography or Works Cited?
3. Does it include a complete index, table of contents, and/or site map?
4. Is there a bias?
   - Author’s purpose and/or point of view
   - Clear, not hidden
   - Opinions supported by strong evidence, not just the author’s ideas
5. Does it have current and relevant information?
Notecards and Note-Taking

The purpose of notecards is to pull relevant information from your sources in a way that will make them usable in your outline and your paper. On each notecard, you should have

- A word or phrase indicating in which section of your paper this will be used
- The name and/or number of a source
- Bulleted information in your own words or a quotation

By making a notecard, you will have thought about how each source connects to your thesis and also started the process of avoiding plagiarism.

Sample Notecard

<table>
<thead>
<tr>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bradbury, Ray. <em>Fahrenheit 451</em></td>
</tr>
</tbody>
</table>

“Guy’s surprise tonight is to read you one sample to show how mixed up things were, so none of us will ever have to bother our little old heads about that junk again...” (95).

This quote shows Mildred defending the censorship that the government has placed on them, and how she’s been brainwashed into thinking that it’s a good thing. This is good support for Bradbury’s use of censorship in the novel.
Creating an Outline

- The outline is the “road map” or “skeleton” of your research paper.

- The outline is designed to help you organize your main points in a logical and orderly way as well as to save you time when you sit down to write your drafts.

- As you take notes, you should refer back to your outline to see if it relates to your main points. If not, you are getting off track.

There are multiple ways to create an outline.

- Begin by grouping your notecards by the main point/topic of the card.

- The number of sections on the outline will be determined by the number of main points in the paper.

- The outline covers only the body of the paper.

- The complete project will also include the MLA heading and a Works Cited page.

- On the next page is a model for a standard outline.
Standard ELA Outline Model
(Social Studies model will include primary sources)

Your First Name and Last Name
Your Teacher’s Name
Name of Course
Day Month Year Assignment Due

Title

I. Introduction (eventually should be written as a paragraph)
   A. “Hook” (this might be a striking fact, a quotation, an anecdote)
   B. Brief background information connecting the reader to the topic
   C. Working thesis statement

II. First Main Point (write as a topic sentence)
   A. First supporting detail
      1. Example (quote or reference)
      2. Explanation of example and connection to thesis statement
   B. Second supporting detail
      1. Example (quote or reference)
      2. Explanation of example and connection to thesis statement

III. Second Main Point (write as a topic sentence)
   A. First supporting detail
      1. Example (quote or reference)
      2. Explanation of example and connection to thesis statement
   B. Second supporting detail
      1. Example (quote or reference)
      2. Explanation of example and connection to thesis statement
   C. Third Supporting Detail (if needed)

IV. Third Main Point (write as a topic sentence)
   A. First supporting detail
      1. Example (quote or reference)
      2. Explanation of example and connection to thesis statement
   B. Second Supporting Detail
      1. Example (quote or reference)
      2. Explanation of example and connection to thesis statement

V. Conclusion (do not introduce new ideas)
   A. Briefly restate (using different words) the important points made in the body of the paper
      (show the significance of those points)
   B. Summarize your thesis
The Thesis Statement

The thesis statement is the backbone of the research paper. The thesis is a one-sentence statement that presents your conclusions about your topic based on research. The thesis statement takes time and research to develop and cannot be made up without solid support to back it up. You may not discover your final thesis statement until you have completed most of your research and in most cases, your thesis will change several times as you work. It is important to remember that you are NOT writing a report. You are proving something about that event or person. Below are tips and suggestions for developing a strong thesis statement.

A thesis is NOT...
- a description of your paper topic
- a question
- a statement of fact
- a statement of opinion

A thesis IS...
- is developed from research questions posed during your reading
- is an arguable point (it is your job to provide evidence to support your argument)
- is the conclusion of all your research

Examples - Topic: Sacajawea

<table>
<thead>
<tr>
<th>Statement</th>
<th>Is this an effective thesis?</th>
</tr>
</thead>
<tbody>
<tr>
<td>“This paper is about the life of Sacajawea.”</td>
<td>NO</td>
</tr>
<tr>
<td>“Why was Sacajawea so important to the Lewis and Clark Expedition?”</td>
<td>NO</td>
</tr>
<tr>
<td>“I think that Sacajawea was important to the Lewis and Clark Expedition.”</td>
<td>NO</td>
</tr>
<tr>
<td>“The purpose of this paper is to discuss the importance of Sacajawea to the Lewis and Clark Expedition.”</td>
<td>NO</td>
</tr>
<tr>
<td>“Sacajawea was critical to the success of the Lewis and Clark Expedition because of her knowledge of languages, geography, and natural remedies.”</td>
<td>YES</td>
</tr>
</tbody>
</table>

Use the following formula to help you develop your thesis statement:

**THESIS = Topic + Your Position/Argument + 2-3 Main Points (supporting examples)**

Sacajawea was critical to the success of the Lewis and Clark Expedition because of her knowledge of languages, geography, and natural remedies.

This page has been adapted from Mary Lynn Rampolla, A Pocket Guide to Writing in History, 5th ed. (Boston: Bedford/St. Martin’s, 2007), 47-48.
Tips for Writing Your Thesis Statement

1. Determine what kind of paper you are writing.
   - An analytical paper breaks down an issue or an idea into its component parts, evaluates the issue or idea, and presents this breakdown and evaluation to the audience.
   - An expository (explanatory) paper explains something to the audience.
   - An argumentative paper makes a claim about a topic and justifies this claim with specific evidence. The claim could be an opinion, a policy proposal, an evaluation, a cause-and-effect statement, or an interpretation. The goal of the argumentative paper is to convince the audience that the claim is true based on the evidence provided.
   - If you are writing a text that does not fall under these three categories (e.g., a narrative), a thesis statement somewhere in the first paragraph will still be helpful to your reader.

2. Your thesis statement should be specific; it should cover only what you will discuss in your paper and should be supported with specific evidence.

3. The thesis statement usually appears at the end of the first paragraph of a paper.

4. Your topic may change as you write, so you may need to revise your thesis statement to reflect exactly what you have discussed in the paper.
Thesis Statement Examples

Example of an **analytical** thesis statement:

An analysis of the college admission process reveals one challenge facing counselors: accepting students with high test scores or students with strong extracurricular backgrounds.

The paper that follows should
- explain the analysis of the college admission process
- explain the challenge facing admissions counselors

Example of an **expository** (explanatory) thesis statement:

The life of the typical college student is characterized by time spent studying, attending class, and socializing with peers.

The paper that follows should
- explain how students spend their time studying, attending class, and socializing with peers

Example of an **argumentative** thesis statement:

Before entering college in order to increase their maturity and global awareness, high school graduates should be required to take a year off to pursue community service projects

The paper that follows should
- present an argument and give evidence to support the claim that students should pursue community projects before entering college

This page has been adapted from Owl Purdue, On Line Writing Lab, 2014
MLA Manuscript Form
All steps are based on creating a document in Microsoft Word

Use the following guidelines to help you set up the correct format for your research paper. All of the guidelines have been established as the acceptable format for MLA research papers.

1. All of your text should be written in 12-point Times New Roman. This includes the title of your paper.

2. Your entire paper should be double spaced. This includes your heading, any quotations included and the list of works cited. Depending on the program used, you may have to “Remove Space After Paragraph.” This option is found below the “Spacing Options.”

3. The margins of your paper should be set to one inch. You may have to re-set the margins of your paper depending on the default settings of the program you are using. Look under the “Page Layout” tab to set your page margins.

4. Your paper will need a header that includes your last name and a page number. Look under the “Insert” tab and select the “Header” icon. On the drop-down menu, select “Edit Header.” Next, you will need to click on the “Home” tab and “Right Justify” the cursor for your header. Type your last name. Select “Page Number” and click on “Current Position” on the drop-down menu. Select “Plain Number” from the options given. Leave a space between your last name and your page numbers. Start your numbering at 1. The computer should automatically paginate all of your pages once you have completed these steps. All pages, including the Works Cited page, follow this format and are numbered consecutively.

5. Your paper should start with a heading. The first line should include your first and last name. The second line should include your teacher’s title and last name. The third line should include the course name. The final line should include the full date your research paper is due. The full date should appear in the international format: date month year. For example: 21 December 2015.

6. Your heading and the text of your research paper should be aligned to the left. Your title should be centered. Use the “Align Text” icons to change the placement of your text. Do not use the space bar or the tab key to align your cursor.
Sample MLA Paper Format

Your Last Name Page Number

Your First Name and Last Name
Your Teacher’s Name
Name of Course
Day Month Year Assignment Due

Title of Paper

The introduction paragraph of your paper should start immediately under your title on the first page of your paper. Each paragraph should be indented by using the “Tab” key. You should strike the “Tab” key once to create your indent. Do not strike the “Enter” key at the end of each line. Instead, just keep typing and the program will determine when a new line needs to be started.

When you are ready to move on to your second paragraph, place it immediately after the previous paragraph. You should not skip extra lines between paragraphs. To create a new paragraph, strike the “Enter” key to move the cursor to a new line. Then, indent your first sentence to indicate a new paragraph. Continue typing your paper.

Remember to follow all of the formatting guidelines indicated on the previous page. Your entire paper, including your title and Works Cited page, should follow the MLA guidelines. Visually, your paper should look like this model.
What is a parenthetical reference?

A parenthetical reference is a reference within the body of your paper to one of the sources listed in your Works Cited list. It indicates to your reader exactly what you derived from the source and specifically where it can be found. You need to write a parenthetical, or "in-text", reference whether you quote the material directly from the source, paraphrase it in your own words, or refer to an idea derived from the material.

What typically goes in an MLA-style parenthetical reference?

The information that you need to include depends on the type of source. For printed material, you normally only need to include the author(s) (or title if there is no author) and page number(s) in your reference. For multi-volume works like encyclopedias, you may also need to include a volume number (see Rules 6 and 7 below). For Internet sources, sometimes paragraph numbers are provided.

What other rules do I need to know in order to write a correct parenthetical reference?

Rule 1: Placement
The parentheses are usually placed at the end of a sentence between the last word and the period. If you are quoting material directly, the parentheses should go between the closing quotation mark and the period. For example:

"The chicken came before the egg" (Smith 21).

Rule 2: Sentence vs. parentheses
Only information that is not already contained in your sentence is necessary in the parenthetical reference. In the following example, the author's last name, Smith, is already stated. Therefore, only the page numbers are necessary within the parentheses. For example:

Smith theorizes that the chicken came before the egg (21).

Rule 3: When there is no author
If the work is listed and alphabetized in your Works Cited page by its title (no author), then you should refer to it in the parenthetical reference by its title as well. The title may be shortened to just the first word (not including articles like "The" and "A"), and should be quoted or underlined if it is quoted or underlined in your source list. For example:

Experts believe that the chicken came before the egg (Chicken 21).
Experts believe that the chicken came before the egg ("Egg" 21).

Rule 4: When there are two entries with the same author (or no author) and title
If you have two entries with the same author (or no author) and title, find a publication fact that distinguishes the works and add it to their parenthetical references. For a nonperiodical print source, use the date of publication if possible. For an article in a periodical, use the title of the periodical. For a Web page, use the title of the overall Web site. For example:

Experts believe that the chicken came before the egg (Smith, 2006).
Experts believe that the chicken came before the egg ("Egg," Student Resource Center).

Rule 5: Referring to an entire work
If you are referring to an entire work (like an opera or an entire novel) and not a specific section of the work, state the author and/or title within the sentence and do not add any further information in parentheses. For example:

Smith's opera, "Chicken and Egg", is a light-hearted comedy.
Sample of Common Works Cited

**Database →**

**Student Resources**

**Sample Database →**

**Student Resources in Context** - published somewhere else (note that if you are including the URL, you want to use the bookmark as it will include the database log in in the URL)

**Sample Book →**

**Web Site →**

**Sample Web Site →**

---

**Works Cited**

**AuthorLastName, FirstName. "Title of Article."** *Title of Original Source-Found Under the Article Title.* City of Publication: Publisher, © Date. *Name of Database.* Web. Date You Viewed. <http://bookmarkedURL>.


© Date Format

**LastName, FirstName. "Title of Article."** *Name of Web Site.* Website Publisher, 2013.


URL is not required but VERY useful
MLA Standard Format for Works Cited Page

- The title of “Works Cited” is centered at the top of the page.
- The entire Works Cited is double spaced.
- Every entry has a hanging indent.
- All entries are in alphabetical order.
- All titles are capitalized (book, article, database, Website etc…).
- Titles of articles are in “quotation marks”.
- Titles of original publication and databases are in *italics*.
- Omit corporation names such as Inc, Corp, Publishers, University, LLC.

Smith 9

**Works Cited**


<http://ic.galegroup.com/ic=Bookmark&u=nysl_ro_genehse4abe76653fd7a1ac>.

Online Resources

Geneseo Middle/High Library:
URL: http://www.geneseocsd.org/Middlehigh.cfm?subpage=111812
• Database Passcode: geneseolibrary

MLA Formatting and Style:
URL: http://owl.english.purdue.edu/owl/resource/557/01/
• Purdue University’s Online Writing Lab is a reliable source of information about MLA style citations and documentation.

NoodleTools (NoodleBib):
URL: http://www.noodletools.com
• An online subscription tool paid for by GCSD for students to properly keep track of sources and generate entries for bibliographies, Works Cited lists, and reference lists. Format choices include MLA, APA, and Chicago/Turabian.
• Noodlebib Username = first initial, last name, “dot”, graduation year
  Password = student number
  Revalidation Code = geneseohigh/ghslib

Research and Documentation Online:
URL: http://www.dianahacker.com/resdoc/home.html
• This website from Bedford-St. Martin’s Press contains guides to research in the humanities, social sciences, history, and sciences and sample papers which show how to cite sources and format your work. The site also contains a glossary of research terms, list of style manuals, and tips for evaluating sources.

Saying It Like It (Exactly) Is:
URL: http://web.ku.edu/~edit/quotes.html
• Designed for journalists, this website provides guidelines for how and when to use quotations effectively in writing.
Glossary

**Annotated Bibliography**: An annotated bibliography is a list of citations of research materials, including books, articles, or other documents. Each citation is followed by a brief descriptive paragraph and sometimes an evaluative paragraph. These paragraphs are called annotations. The purpose of the annotation is to inform the reader of the content, usefulness, and quality of the sources used in the research.

**Bibliography**: This is a comprehensive listing of any sources consulted during the research of a topic, question, or problem.

**Cite**: Citing is the act of giving credit to the sources used within the research paper. All information taken from sources and used in your research paper must be cited.

**Credibility**: A source is credible when it is worthy of trust or belief. Signs of credibility may include reputation of the publisher or sponsor, authority of authors, and transparency of purpose.

**Database**: A data base is an online collection of scholarly articles and information that is usually paid for by your school or state.

**Evidence**: Writers should include evidence to support their claims. Evidence includes facts, figures, details, quotations, or other sources of data and information that provide support for claims or an analysis. Others should be able to evaluate your evidence, and it should be derived from an appropriate source.

**Parenthetical Documentation**: This is a system for giving credit to authors for their word or for their ideas. All items that receive parenthetical documentation in your research paper must have a corresponding citation on the Works Cited page.

**Plagiarism**: Plagiarism is the representation of another’s ideas or writing as your own.

**Primary Source**: A primary source is an original document or object from the time period under study or a first-hand account. In historical research, primary sources may include artifacts, speeches, photographs, government documents, eyewitness accounts, and creative works.

**Research Paper**: This is the culmination and final product of an involved process of research, critical thinking, source evaluation, organization, and composition.

**Secondary Source**: A secondary source is any published or unpublished work that is one step removed from the original source. This could be a work which interprets or evaluates primary source materials. Types of secondary sources may include any of the following: a review, a critical analysis, a second-person account, or a biographical or a historical study.

**Thesis**: A thesis statement defines and limits the scope of the paper. It is a controlling idea that offers an opinion that the writer must defend or prove throughout the paper through the use of appropriate and convincing evidence.

**Works Cited Page**: This is a reference list appearing as the last page of a research paper listing the sources cited within that paper.